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1. Introduction 
 
The K81 point-of-sale (POS) Card Reader Solution is a collection of hardware, software 
enablement, middleware and specialized application-specific software for the point-of-
sale market. This document describes how to start with the kit: use it for payment 
application demonstration and start working with the dedicated software. 

 

 

Fig 1. POS Reader Solution Kit box 

 

All details about the solution can be found on the NXP webpage: 

www.nxp.com/products/reference-designs/point-of-sale-pos-reader-solution:SLN-POS-
RDR 

http://www.nxp.com/products/reference-designs/point-of-sale-pos-reader-solution:SLN-POS-RDR
http://www.nxp.com/products/reference-designs/point-of-sale-pos-reader-solution:SLN-POS-RDR
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2. POS Reader Solution kit 

2.1 Kit Content 
 

 

Fig 2. Kit Content 

 

The individual components of the POS Reader Solution Kit are described in the below 
subsections. 

 
  



 

 

NXP Semiconductors UM11036 
 Point of Sales (POS) Reader Solution - Quick Start Guide 

 UM11036 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2019. All rights reserved. 

User manual                                                                        
COMPANY PUBLIC 

Rev. 1.3 — 27 May 2019                                                                       
406512 

5 of 57 

2.1.1 TWR-POS-K81 
This is the core of the SLN-POS-RDR system. This board embeds the K81 
microcontroller, external flash, an LCD display and the secure pin pad. 

 

 

Fig 3. TWR-POS-K81 
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2.1.2 TWR-POS-PN5180 
2.1.2.1 Presentation 

This is the card interface board. It allows reading Contact and Contactless payment 
cards. This board embeds NXP’s PN5180 (contactless frontend) and TDA8035 (contact 
frontend) 

 

Fig 4. TWR-POS-PN5180 

 

2.1.2.2 Jumper settings 
The jumpers on the TWR-POS-PN5180 are used to connect this board to different CPU 
modules. The setting for these jumpers, to be used in this kit, is the one seen in Fig 4. 
Below table gives the position of each jumper to be used in this RDR-POS-SLN: 

Table 1. TWR-POS-PN5180 Jumper setting for RDR-POS-SLN 
Jumper name Setting Jumper name Setting 

J1 1-2 J2 1-2 
J3 1-2 J4 1-2 

J5 1-2 J6 4-6 
J7 4-6 J8 4-6 
J9 Open J10 Open 

J11 1-2 J12 1-3-5 1-3 
J12 2-4-6 2-4 J16 1-2 Open 
J16 3-4 Open J19 2-3 

J20 1-2 J21 Open 
J22 1-2 J23 1-2 
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2.1.3 TWR-POS-CLRC663 
2.1.3.1 Presentation 

This is the card interface board. It allows reading Contact and Contactless payment 
cards. This board embeds NXP’s CLRC663 (contactless frontend) and TDA8035 (contact 
frontend) 

 

Fig 5. TWR-POS-CLRC663 

 

2.1.3.2 Jumper settings 
The jumpers on the TWR-POS-CLRC663 are used to connect this board to different CPU 
modules. The setting for these jumpers, to be used in this kit, is the one seen in Fig 4. 
Below table gives the position of each jumper to be used in this RDR-POS-SLN: 

position of each jumper to be used in this RDR-POS-SLN: 

Table 2. TWR-POS-CLRC663 Jumper setting for RDR-POS-SLN 
Jumper name Setting Jumper name Setting 

J1 1-2 J2 1-2 
J3 1-2 J4 1-2 
J5 1-2 J6 4-6 
J7 4-6 J8 4-6 
J9 Open J10 Open 

J11 1-2 J12 1-3-5 1-3 

J12 2-4-6 2-4 J16 1-2 Open 
J16 3-4 Open J19 2-3 

J20 1-2 J21 Open 
J22 1-2 J23 1-2 
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2.1.4 TWR-LCD 
This is an LCD module board. This LCD touchscreen is used to interact with the user: 
display information and get inputs from the user. 

 

Fig 6. TWR-LCD 

 

2.1.5 TWR-Elev 
These are the connection boards. They are needed to connect all feature boards 
together 

 

Fig 7. TWR-Elev 
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2.1.6 Accessories 
2.1.6.1 Cables 

Two USB cables are provided: One USB Mini to provide power to the system, and one 
USB Micro to interface with a computer 

2.1.6.2 Battery 
A CR2032 Button Cell battery is provided. The battery has to be inserted in the battery 
slot on the TWR-POS-K81 board 

2.1.6.3 Sample Card 
One sample card is included. It is a demo Payment card with dual interface (Contact + 
Contactless). The card embeds a secure processor with JCOP OS, running a payment 
application. 

This payment application can be accessed through Contact or Contactless interface. 

 

Fig 8. Sample card 

2.2 Setup the kit 
The kit is delivered already assembled, but in case it is received disassembled or is 
disassembled during operation, the next chapters describe how to assemble it. 

2.2.1 TWR-Elev Primary and Secondary boards 
It is important for the next steps to differentiate the Primary and Secondary TWR-Elev 
boards. Depending on the version, the name of the board can be written: 

“Secondary board” or “Primary board” on the inner side (i.e the side with the 4 female 
PCI connectors). 

If the name is not printed on the board, the Primary can be found by its marking “A side 
expansion port” and “B side expansion port”, while the Secondary board embeds “C side 
expansion port” and “D side expansion port” 
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2.2.2  Assemble the Hardware 
 

The TWR-LCD has to be connected on the outside of TWR-Elev Primary board. 

 

Fig 9. TWR-LCD connected on TWR-Elev primary 

 

TWR-POS-K81 and TWR-POS-PN5180 or TWR-POS-CLRC663 have to be connected 
in the TWR-Elev PCI slots.  

The primary and secondary connectors of each board have to be connected respectively 
on the primary and secondary TWR-Elev boards. The side can be recognized by its 
marking on each board as shown in Fig 10. 

  



 

 

NXP Semiconductors UM11036 
 Point of Sales (POS) Reader Solution - Quick Start Guide 

 UM11036 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2019. All rights reserved. 

User manual                                                                        
COMPANY PUBLIC 

Rev. 1.3 — 27 May 2019                                                                       
406512 

11 of 57 

 
 

 

Fig 10. TWR-POS-K81 and TWR-POS-PN5180 or TWR-POS-CLRC663 sides 

The most convenient way is to have the K81 board on the top connector, and the 
PN5180 or CLRC663 board on the bottom connector: 

 



 

 

NXP Semiconductors UM11036 
 Point of Sales (POS) Reader Solution - Quick Start Guide 

 UM11036 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2019. All rights reserved. 

User manual                                                                        
COMPANY PUBLIC 

Rev. 1.3 — 27 May 2019                                                                       
406512 

12 of 57 

 

Fig 11. SLN-POS-RDR Hardware mounted 
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The battery has to be inserted in the battery slot, underneath the TWR-POS-K81 PCB: 

 

Fig 12. Battery location 

To insert the battery in the right way, the + symbol has to be on top (visible), as seen in 
next figure: 

 

 

Fig 13. Battery position 
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2.3 USB Connections 
The Kit presents 3 USB connectors: 
• One Mini USB on the TWR-Elev board 
• One Mini USB on the TWR-LCD board 
• One Micro USB on the TWR-POS-K81 board 

See Fig 15 and Fig 16 for each connector’s location. 

In order to operate the Tower Kit, both the Micro USB, underneath TWR-POS-K81 board, 
and the Mini USB on the TWR-ELEV board have to be used. 

Micro USB has to be connected to the host computer (running the high-level application) 
and the TWR-ELEV mini USB has to be connected to a power source (either from a 
computer USB or from a power socket USB). Both are needed to ensure the Kit will have 
enough power to operate in all modes. 

 

Fig 14. Connections for demo operations 

 

 

Fig 15. Connector location – Micro USB 
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Fig 16. Power supply connector location – Mini USB 

2.4 TWR-ELEV Power Switch 
A switch is mounted on the TWR-ELEV board. This switch is used to turn ON or OFF the 
power supply from the TWR-ELEV USB connector. 

For the SLN-POS-RDR to operate, the switch has to be in the ON position (top) shown in 
Fig 17, otherwise there will be no power from this TWR-ELEV connector. 
 

 

Fig 17. TWR-ELEV – Power switch ON position 
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3. Demonstration 

3.1 Setup the environment 
After the Hardware is assembled and connected, the computer has to be set up in order 
to operate the payment demonstration: the TWR_POS_K81 module embeds a USB to 
Serial converter, accessed through the mini USB port connected to the computer. 

When this USB is connected, the host computer should display an unknown device in the 
device manager. 

The dedicated driver for this device has to be installed so that the computer gets a new 
COM port that will be used to connect to the POS Reader Solution Kit. This can be done 
following the below steps: 

 Locate the .inf file for this driver: It is delivered with the software package. It is called 
fsl_ucwxp.inf and is located in the folder 
“boards\twrposk81\demo_apps\payment_demo\cardtek_ihs_app” 

 Open the device manager 
 Locate the unknown device. This should be a device with a Yellow Bang, named 
“MCU VIRTUAL COM DEMO”. See Fig 18. 

 Right click on this device, and choose “Update Driver Software” 
 Select “Browse my computer for driver software” 
 “Let me pick from a list…” 
 “Show all devices” then “Next” 
 “Have Disk” 
 Click “Browse”, navigate to the folder containing the above mentioned .inf file, and 
select this .inf file.  

 Windows should propose a Virtual COM port (see Fig 19). Select it then click “Next” 
 Note that Windows may show a warning saying that the driver is not digitally signed. 
To install it anyway, the computer must be configured to disable driver signature 
enforcement. 

If the computer is not correctly configured, it can be done following Microsoft help. 
E.g. https://msdn.microsoft.com/en-us/windows/hardware/drivers/install/installing-an-
unsigned-driver-during-development-and-test 

Note that the above link may not give the exact process depending on the computer 
OS version. 

 Windows may then show some messages asking to confirm that you want to install 
this driver. Accept by selecting “Install this driver Software anyway” 

 Windows will install the driver 
 When the driver is installed, it may happen that Windows shows a message 
informing that the driver cannot start. In such a case, unplug then plug back the USB 
connection. This should restart the driver, so that it is seen as running (no error) in 
the device manager (see Fig 20). 
 

https://msdn.microsoft.com/en-us/windows/hardware/drivers/install/installing-an-unsigned-driver-during-development-and-test
https://msdn.microsoft.com/en-us/windows/hardware/drivers/install/installing-an-unsigned-driver-during-development-and-test
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Fig 18. Uninstalled COM port driver 

 

 

Fig 19. Select proposed driver for Virtual COM port 
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Fig 20. Installed driver 
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3.2 First power-up of the kit 
At first power-up, the POS-RDR-SLN kit will ask for a calibration of the side LCD screen. 
This calibration requires the user to touch the screen at two specific locations. 

To do so, touch the screen on the displayed crosses when prompted See Fig 21 and Fig 
22. 

 

Fig 21. LCD Screen - Calibration #1 

 

 

Fig 22. LCD Screen - Calibration #2 

 

Right after this operation, the LCD will display the demo screen. See next chapter. 
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3.3 Payment Demo application 
This application demonstrates a full payment application using a sample payment card, 
and an issuer payment application, running on the computer. This tool is called “Issuer 
Host Simulator” (IHS).  

The following chapters describe the way to use the default demonstration. For more 
details, refer to [2]. 

 

3.3.1 Launch the demonstration 
To start the demonstration: 

 Plug the POS Reader Kit Mini USB (power) 
 Plug the Micro USB to the computer (communication). Note the COM port value 
assigned in the device manager. 

 Launch the Issuer Host Simulation (IHS) Tool that can be found in the SW release 
package, in the folder 
K81POSCR_SW_Release\boards\twrposk81\demo_apps\payment_demo\cardtek_ih
s_app 
The tool is the application named “IHS.exe”. 

 

Fig 23. Issuer Host Simulation tool window 

 In the COM Port configuration window, select the COM port value noted at step 2. 
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 Click on “Connect”. 
 !! First time only !! – The first time the IHS is connected to the tool, it will download 
some configuration files. Wait for this process to finish, then the demo can be used. 

 The TWR-ELEV LCD (color LCD) asks to pick an action: “Config” or “Payment”. 

 

Fig 24. Demo start screen 

 Select “Payment” by touching the screen 
 The application asks to enter a transaction amount. This value has to be entered with 
the secure pin pad on top of the solution. (e.g. 15.00 can be entered) 
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Fig 25. Enter amount screen 

 The amount is displayed on both LCD screen: on the TWR-POS-K81 2 lines LCD, 
and on the side color LCD. 
 

 

Fig 26. Pin pad - Enter amount 
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 Press “Enter” on the secure pin pad to validate the amount. 
 The LCD screens ask to insert or tap a card. From this point, Contact or Contactless 
transactions can be used. For contact transaction, go to step 13, and for contactless 
operation, go to step 15. 

 Contact operation 
a. Insert the sample card into the Contact Smart Card reader (located under the 

TWR-POS-PN5180 module or TWR-POS-CLRC663 module). The smart card has 
to be inserted with contacts and prints on top: 

 

Fig 27. Contact card insertion 

 
b. The process continues and you are requested to enter the card PIN. Enter the 4 

digits pin code on the TWR-POS-K81 module pin pad, then press Enter. The 
default pin code is “1234”.  

c. If the POS Reader Solution is connected to the IHS, and the IHS is active, the 
LCD Screen will show “Online Approved – Remove Card”, and the transaction 
information will be displayed in the IHS dedicated window. 
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Fig 28. Online approved 

 

 

Fig 29. IHS - Transaction details 

 
d. If the POS Reader Solution is not connected to the IHS, the LCD will display 

“Offline Approved – Remove card” 
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Fig 30. Offline approved 

 You can now remove the card. The setup is ready for the next operation. 
 

 Contactless operation 
a. When the POS asks to “Insert or Tap a Card”, the sample card can be tapped on 

the TWR-POS-K81 board antenna: 
 

 

Fig 31. Contactless card tap 
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b. This operation does not request a pin code to be entered. When the card is 
detected, the transaction is processed and the POS displays “Offline Approved – 
Remove Card” 
 

 

Fig 32. Offline approved 
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3.4 Factory Reset 
If the system needs to be set back to its default configuration, it is possible to reset it with 
the factory settings. 

To do so, at start-up screen, choose “Config”: 

 

 

Fig 33. Factory reset #1 

 

Then scroll down the configuration screen to display “Factory Reset” 

Touch “Factory Reset” and then “OK”: 

 

 

Fig 34. Factory reset #2 
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The system will reset its data internally. Several screens will be seen: 

 

Fig 35. Factory reset #3 

 

The process is finished when the screen shows back the “POS Config” menu screen. At 
this point, the HW has to be reset: unplug the two USB cables, and plug them back. 

The system will restart with the screen calibration. See 3.1. 
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4. POS Reader Solution Software 

4.1 Introduction 
The POS Reader Solution kit is delivered with a pre-installed software running the 
Payment Demo application. 

The Software code can also be obtained directly from NXP. Contact your direct NXP 
representative to get access to this software. 

 

The software is delivered in a package containing source code from NXP and libraries 
from third companies. 

The folder tree from this SW code delivery is as follows: 

 

 

Fig 36. Software Delivery – Folder tree 

 

The “boards” folder contains the demonstration example projects that are prepared for 
two IDEs (Integrated Development Environment): IAR and KDS. 

Other folders contain source code and libraries for all embedded features. 

For deeper details about the SW content, refer to [1]. 
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4.2 Software project 
To open the software project, edit, compile and load the Software into K81 target, 2 IDEs 
can be used: IAR and KDS. 

4.2.1 Debug Probe – J-Link 
The program download into the K81 requires a J-Link probe to be connected between 
the computer and the K81 target. 

J-Link probe is used for this purpose and can as well be used to debug the program 
running in the K81 target. This connection requires at a minimum a J-Link Base probe, 
and a 19-pin Cortex-M Adapter, to connect the probe to the K81 module: 

https://www.segger.com/jlink_base.html 

https://www.segger.com/jlink-adapters-19pin-cortexm.html 

Probe drivers should be automatically installed during the installation of the IDE. 

The probe and the adapter are not part of the kit. They have to be purchased 
separately. 
The first time the probe is used, its driver has to be installed. Driver and instructions can 
be found under JLINK website: choose the “J-Link Software and Documentation 
Pack” download: 

https://www.segger.com/downloads/jlink 

 

4.2.2 Debug information (printf) 
Some debug information can be received through UART, using a Serial board extension.  

 

 

Fig 37. TWR-SER 

 

This board is not part of the kit, but can be purchased directly from NXP: 

TWR-SER NXP Web page 

 

https://www.segger.com/jlink_base.html
https://www.segger.com/jlink-adapters-19pin-cortexm.html
https://www.segger.com/downloads/jlink
http://www.nxp.com/products/software-and-tools/hardware-development-tools/tower-development-boards/peripheral-modules/serial-usb-ethernet-can-rs232-485-tower-system-module:TWR-SER
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In order to use this board and display the printf messages from the software, the TWR-
SER module has to be inserted in the POS-RDR-SLN Kit. As for the other modules, the 
primary and secondary interfaces have to match the right side of the TWR-ELEV boards. 

 

 

 

Fig 38. TWR-SER in the POS-RDR-SLN Kit 

 

 

Once inserted, the Serial port seen in Fig 38 has to be connected to a computer COM 
port. On the computer, open a COM port terminal, with a speed of 115200 bps, and the 
data will be displayed as the software runs. 

 
  



 

 

NXP Semiconductors UM11036 
 Point of Sales (POS) Reader Solution - Quick Start Guide 

 UM11036 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2019. All rights reserved. 

User manual                                                                        
COMPANY PUBLIC 

Rev. 1.3 — 27 May 2019                                                                       
406512 

32 of 57 

4.2.3 Using IAR 
This chapter describes how to open and run the project Payment Application Demo. 

IAR must be pre-installed with a valid license before going through these steps.  

The minimum required IAR version is 7.70.0. 

4.2.3.1 Open the project and compile 
1. Locate the .eww file from the demo project folder: 

K81POSCR_SW_Release\boards\twrposk81\demo_apps\payment_demo\iar 

2. Double click on the .eww file. It will open the project in IAR. 

Alternatively, if the .eww files are not linked to IAR, the following step have to be done. 
Otherwise, jump to step 6. 

3. Open IAR 

4. Select File>Open>Project and browse to the folder containing the IAR project file 
(extension is .eww). 

5. Select the file payment_demo.eww 

The project contains two subprojects: Payment_demo and lib_pos: 

 

Fig 39. Payment Demo project tree 

The Payment_demo project is the main application. It requires the lib_pos library 
to compile. 

The compilation must then start with this lib_pos project. 

6. Right click on the lib_pos project, and select Make 
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Fig 40. Start compiling – lib_pos 

 

7. Once the lib_pos library is compiled, a library lib_pos.a must be found in 
K81POSCR_SW_Release\boards\twrposk81\demo_apps\payment_demo\iar\lib_
pos\debug (if debug configuration mode is used) 

8. Build the Payment_demo app by right-clicking on the payment_demo solution, 
and choosing “Make”. 

9. The software is now built and can be loaded into the POS Reader Solution K81 
target. 
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4.2.3.2 Download Software 
Downloading Software requires the J-Link probe to be connected to the computer over 
USB, and to the TWR-POS-K81 module, through the 19-pin Adapter. See Fig 41. 

 

Fig 41. J-Link probe connections 

The J-Link probe has to be connected to the connector shown in Fig 42. 

 

Fig 42. J-Link connector location on TWR-POS-K81 bottom side 
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With the probe connected and the kit powered, select Project >Download>Download 
Active Application in IAR. 

Note: The K81 must be powered to perform this application. 

 

 

Fig 43. IAR Download application 
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4.2.3.3 Debug Software 
To run the software in debug mode, the same J-Link probe can be used with the same 
connection. 

To start the debug mode, simply click the debug button or select Project>Download and 
Debug: 

 

 

Fig 44. IAR Launch debug mode 
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4.2.4 Using KDS 
4.2.4.1 Install and start KDS 

KDS (Kinetis Design Studio) has to be installed first. The KDS installation can be found 
from NXP website: 

www.nxp.com/products/software-and-tools/run-time-software/kinetis-software-and-
tools/ides-for-kinetis-mcus/kinetis-design-studio-integrated-development-environment-
ide:KDS_IDE 

The minimum required KDS version is 3.2.0. 
Once KDS is installed, launch the application. KDS first asks to select a folder that will 
become the Workspace for this KDS session. 

Select any folder on the local disk. It doesn’t have to contain data at first. 

Remember the folder location: next time KDS will be open, this workspace will have to be 
selected to retrieve the ongoing projects. The workspace will not necessarily contain 
source code, but it will contain all configuration and information about current projects. 

 

Fig 45. Select KDS Workspace 

 
When the workspace path is selected, KDS opens with its welcome information page: 

http://www.nxp.com/products/software-and-tools/run-time-software/kinetis-software-and-tools/ides-for-kinetis-mcus/kinetis-design-studio-integrated-development-environment-ide:KDS_IDE
http://www.nxp.com/products/software-and-tools/run-time-software/kinetis-software-and-tools/ides-for-kinetis-mcus/kinetis-design-studio-integrated-development-environment-ide:KDS_IDE
http://www.nxp.com/products/software-and-tools/run-time-software/kinetis-software-and-tools/ides-for-kinetis-mcus/kinetis-design-studio-integrated-development-environment-ide:KDS_IDE
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Fig 46. KDS Welcome page 
 
Close this page, and KDS will show its default view: 
 

 

Fig 47. KDS default view – No project 
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4.2.4.2 Import the project and compile 
 
From here, the Payment_demo application project can be imported, following below 
steps: 

 Select in the menu: File>Import 
 In the ‘Import’ Window, select ‘General’, then ‘Existing Project into Workspace’ 

 

Fig 48. Import Project 

 Click ‘Next’ 
 Check ‘Select root directory’, and Browse to the following folder (or enter the path to 
the following folder in the path field: 
K81POSCR_SW_Release\boards\twrposk81\demo_apps\payment_demo\kds 

 Then press ‘Enter’. The existing projects will be shown in the below window: 
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Fig 49. Projects to import from payment-demo application 

 
 Select the two projects (payment_demo and lib_pos), make sure the option boxes 
are not checked, and click Finish. 

 Projects are now imported 
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Fig 50. Projects imported 

 
 Projects can now be compiled: Right click on ‘lib_pos’ projects in the left panel, and 
select ‘build’ 

 

Fig 51. Build lib_pos 
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  When the build is completed, do the same with the payment_demo project. 

Note that the compilation order is important: lib_pos is a library which is needed by the 
payment_demo application. If the payment_demo application project is compiled first, the 
compilation may fail, or the project wouldn’t include the latest changes from lib_pos. 

Once both builds are done, the full project is compiled and ready to use. 

 

4.2.4.3 Download Software and debug 
Downloading Software requires the J-Link probe to be connected to the computer over 
USB, and to the TWR-POS-K81 module, through the 19-pin Adapter. See Fig 52. 

 

Fig 52. J-Link probe connections 

The J-Link probe has to be connected to the connector shown in Fig 42. 
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Note: The K81 must be powered to perform this application. 

To download the software through the debug mode, open the debug configurations menu 
by clicking the little bug in the menu bar and selecting “Debug Configurations…”: 

 

 

Fig 53. Open ‘Debug configurations’ menu 
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In the menu, select “payment_demo_twrposk81 debug jlink”, and click debug: 

 

Fig 54. Start debug mode 

 

The software will be loaded into K81 through the J-Link probe, and KDS will change its 
perspective to the debug view. 

Press the F8 key to launch the program, or press F5 to run step by step. 
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4.3 PN5180 Firmware update procedure 
4.3.1 Introduction 

The TWR-POS-PN5180 board includes a contactless reader device which embeds a 
controller and its own Firmware for contactless operations. 

In some cases, this FW has to be upgraded – For instance when a new EMVCo 
specification has to be supported. 

This chapter describes the PN5180 secure firmware update application. Application 
allows customer to update PN5180 firmware to the latest firmware version. 
pn5180_firmware_update will check the onboard PN5180 firmware and notifies the user 
to update to the latest version if needed. Hardware modifications are required only for 
existing/legacy TWR-POS boards already in the field to perform firmware update which 
will be described in detail in the further sections. 

4.3.2 Secure Firmware Update Flow Diagram 
The next figure shows the PN5180 secure FW update application flow. 



 

 

NXP Semiconductors UM11036 
 Point of Sales (POS) Reader Solution - Quick Start Guide 

 UM11036 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2019. All rights reserved. 

User manual                                                                        
COMPANY PUBLIC 

Rev. 1.3 — 27 May 2019                                                                       
406512 

46 of 57 

 

Fig 55. PN5180 Firmware update – Block diagram 

 

The above block diagram shows the pn5180_firmware_update application flow. Firmware 
version of onboard PN5180 is compared with the latest firmware version which is 
available for download. If firmware versions are the same, graphic LCD is updated with a 
UI message saying that “PN5180 already updated” and stops the application. If firmware 
versions are not the same, prints a UI message "Update Firmware version X.X to Y.Y?" 
(Whereas X.X is current version and Y.Y is the version to update to). In case user 
confirms by pressing “OK” on graphic LCD then application performs PN5180 firmware 
update and prints out status message like “Update successful” or “Update Failed!!!”. 
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4.4 Hardware Modifications 
Chapters 4.4.1 and 4.4.2 describe board modifications on TWR-POS-PN5180 and TWR-
POS-K81 boards allowing download of PN5180 Firmware. 

POS kits delivered after 8 February 2017 already include these changes. 

4.4.1 TWR-POS-PN5180 Board Modification 
Current TWR-POS-PN5180 board includes NC (Non Connected) R41 as shown in below 
schematic. Add 0 Ohm resistor in place of “R41 NC”. See the below board image to 
identify the R41 resistor placing.  

 

 

Fig 56. R41 on schematics 

 

 

Fig 57. R41 location 
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4.4.2 K81 Mother Board Modification 
Current K81 mother board includes R12 DNP as shown in the snap below. 

 

Fig 58. R12 on schematics 

 

 

Fig 59. R12 location 
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4.5 PN5180 firmware update   
4.5.1 PN5180 Latest Firmware update 

Make sure the two mandatory hardware changes are done as mentioned above before 
downloading pn5180_firmware_update application into the board.  

The “demo_apps” folder contains the pn5180_firmware_update example project that is 
prepared for two IDEs: IAR and KDS. Build and load the application into the board with 
the chosen IDE. 

For more details on how to build and load the project, refer to section 4.2.3 for IAR or 
4.2.4 for KDS. The only difference is the name of the main project: replace 
“payment_demo” by “secure_fw_update”. 

 

Upon executing pn5180_firmware_update will check the current firmware version in 
PN5180.  

 If the current version is already latest, then no more action required and graphic LCD 
is displayed with “PN5180 already updated”. 

 If the current version is NOT latest, then graphic LCD is displayed with “Update 
Firmware version X.X to Y.Y?”. 

 

Fig 60. Firmware update screen 

 
 Press “OK” to update PN5180.  
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PN5180 will be updated to the latest 3.9 version and “Update Successful” is displayed 
on graphic LCD.  

 

Fig 61. “Update Successful” message 

 

Restarting the board again should result in “PN5180 already updated” 

 

Fig 62. “Already updated” message 
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4.6 Add New PN5180 firmware version 
4.6.1 Adding new PN5180 firmware to pn5180_firmware_update 

Minor changes are required to add a new PN5180 firmware version support in 
pn5180_firmware_update application. The “demo_apps” folder contains the 
pn5180_firmware_update example project that is prepared for two IDEs: IAR and KDS. 

 

1. Add PN5180 FW_Y_Y.h header file to the pn5180_firmware_update project with 
the chosen IDE, similar to the image shown below for FW_3_6.h, FW_3_8.h & 
FW_3_9.h versions. 

  

          

Fig 63. KDS & IAR – Firmware file tree 

 

2. Include the FW_Y_Y.h in pn5180_firmware_update_app.c as indicate below. 

 

KDS IDE 

IAR IDE 
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Fig 64. .h file include 

     
3. Add a macro define for the new firmware version in pn5180_firmware_update.h, 

similar macro defines are shown below. 
 

 

Fig 65. Add macro define 
 
If the firmware version is Y.Y assign macro value as 0xYY for example if the version is 
4.0 then assign macro value as 0x40. 

 
 

  

Include here 
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4. Assign the defined macro to PN5180_FW_VER in pn5180_firmware_update.h 
file similar to the image shown below. 

 

Fig 66. Assign the new FW version 

 

5. PN5180 new firmware header file FW_Y_Y.h will contain an array and its length. 
Assign array to PN5180_FW_VER_BIN_ARRAY macro and the length variable 
to PN5180_FW_VER_BIN_LEN in pn5180_firmware_update.h file as shown 
below. 

 

 

Fig 67. Assign pointer and length 

 

By this all the changes are done, build the lib_pos and pn5180_firmware_update projects 
and load the application into the board. To update PN5180 firmware to latest Y.Y version 
please refer to section 4.5 (PN5180 firmware update). 
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6. Legal information

6.1 Definitions 
Draft — The document is a draft version only. The content is still under 
internal review and subject to formal approval, which may result in 
modifications or additions. NXP Semiconductors does not give any 
representations or warranties as to the accuracy or completeness of 
information included herein and shall have no liability for the consequences 
of use of such information. 

6.2 Disclaimers 
Limited warranty and liability — Information in this document is believed to 
be accurate and reliable. However, NXP Semiconductors does not give any 
representations or warranties, expressed or implied, as to the accuracy or 
completeness of such information and shall have no liability for the 
consequences of use of such information. NXP Semiconductors takes no 
responsibility for the content in this document if provided by an information 
source outside of NXP Semiconductors. 

In no event shall NXP Semiconductors be liable for any indirect, incidental, 
punitive, special or consequential damages (including - without limitation - 
lost profits, lost savings, business interruption, costs related to the removal or 
replacement of any products or rework charges) whether or not such  
damages are based on tort (including negligence), warranty, breach of 
contract or any other legal theory. 

Notwithstanding any damages that customer might incur for any reason 
whatsoever, NXP Semiconductors’ aggregate and cumulative liability 
towards customer for the products described herein shall be limited in 
accordance with the Terms and conditions of commercial sale of NXP 
Semiconductors. 

Right to make changes — NXP Semiconductors reserves the right to make 
changes to information published in this document, including without 
limitation specifications and product descriptions, at any time and without 
notice. This document supersedes and replaces all information supplied prior 
to the publication hereof. 

Suitability for use — NXP Semiconductors products are not designed, 
authorized or warranted to be suitable for use in life support, life-critical or 
safety-critical systems or equipment, nor in applications where failure or 
malfunction of an NXP Semiconductors product can reasonably be expected 
to result in personal injury, death or severe property or environmental 
damage. NXP Semiconductors and its suppliers accept no liability for 
inclusion and/or use of NXP Semiconductors products in such equipment or 
applications and therefore such inclusion and/or use is at the customer’s 
own risk.  

Applications — Applications that are described herein for any of these 
products are for illustrative purposes only. NXP Semiconductors makes no 
representation or warranty that such applications will be suitable for the 
specified use without further testing or modification.  

Customers are responsible for the design and operation of their applications 
and products using NXP Semiconductors products, and NXP 
Semiconductors accepts no liability for any assistance with applications or 
customer product design. It is customer’s sole responsibility to determine 

whether the NXP Semiconductors product is suitable and fit for the 
customer’s applications and products planned, as well as for the planned 
application and use of customer’s third party customer(s). Customers should 
provide appropriate design and operating safeguards to minimize the risks 
associated with their applications and products.  

NXP Semiconductors does not accept any liability related to any default, 
damage, costs or problem which is based on any weakness or default in the 
customer’s applications or products, or the application or use by customer’s 
third party customer(s). Customer is responsible for doing all necessary 
testing for the customer’s applications and products using NXP 
Semiconductors products in order to avoid a default of the applications and 
the products or of the application or use by customer’s third party 
customer(s). NXP does not accept any liability in this respect. 

Export control — This document as well as the item(s) described herein 
may be subject to export control regulations. Export might require a prior 
authorization from competent authorities. 

Translations — A non-English (translated) version of a document is for 
reference only. The English version shall prevail in case of any discrepancy 
between the translated and English versions. 

Evaluation products — This product is provided on an “as is” and “with all 
faults” basis for evaluation purposes only. NXP Semiconductors, its affiliates 
and their suppliers expressly disclaim all warranties, whether express, 
implied or statutory, including but not limited to the implied warranties of non-
infringement, merchantability and fitness for a particular purpose. The entire 
risk as to the quality, or arising out of the use or performance, of this product 
remains with customer. 

In no event shall NXP Semiconductors, its affiliates or their suppliers be 
liable to customer for any special, indirect, consequential, punitive or 
incidental damages (including without limitation damages for loss of 
business, business interruption, loss of use, loss of data or information, and 
the like) arising out the use of or inability to use the product, whether or not 
based on tort (including negligence), strict liability, breach of contract, breach 
of warranty or any other theory, even if advised of the possibility of such 
damages.  

Notwithstanding any damages that customer might incur for any reason 
whatsoever (including without limitation, all damages referenced above and 
all direct or general damages), the entire liability of NXP Semiconductors, its 
affiliates and their suppliers and customer’s exclusive remedy for all of the 
foregoing shall be limited to actual damages incurred by customer based on 
reasonable reliance up to the greater of the amount actually paid by 
customer for the product or five dollars (US$5.00). The foregoing limitations, 
exclusions and disclaimers shall apply to the maximum extent permitted by 
applicable law, even if any remedy fails of its essential purpose. 

6.3 Trademarks 
Notice: All referenced brands, product names, service names and 
trademarks are property of their respective owners. 
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